2. To: (Receiving Organization)  
   Distribution

3. From: (Originating Organization)  
   TFR&SO

4. Related EDT No.:

5. Proj./Prog./Dept./Div.:  
   Project W-314/RPP

6. Design Authority/Design Agent/Cog. Engr.:  
   D.E. Bowers

8. Originator Remarks:
   This modification will not change collective dose since it has no impact on radiological sources, contamination control, or shielding. USO not required per HNF-IP-0842, Vol. IV, Section 5.4, Rev. 12

11. Receiver Remarks:  
   11A. Design Baseline Document? ☑ Yes ☐ No

15. DATA TRANSMITTED

<table>
<thead>
<tr>
<th>(A) Item No.</th>
<th>(B) Document/Drawing No.</th>
<th>(C) Sheet No.</th>
<th>(D) Rev. No.</th>
<th>(E) Title or Description of Data Transmitted</th>
<th>Approval Designator</th>
<th>Reason for Transmittal</th>
<th>Disposition (H) &amp; (I)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RPP-6764</td>
<td>0</td>
<td>Master Pump Shutdown Q</td>
<td>Software Quality</td>
<td>Assurance Plan (SQAP)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

16. KEY

<table>
<thead>
<tr>
<th>Approval Designator (F)</th>
<th>Reason for Transmittal (G)</th>
<th>Disposition (H) &amp; (I)</th>
</tr>
</thead>
<tbody>
<tr>
<td>E, S, O, D OR N/A</td>
<td>4. Review</td>
<td>1. Approved</td>
</tr>
<tr>
<td>(See WHC CM-3-5, Sec. 12.7)</td>
<td>5. Dist. (Receipt Acknow. Required)</td>
<td>2. Disapproved w/comment</td>
</tr>
</tbody>
</table>

17. SIGNATURE/DISTRIBUTION

(See Approval Designator for required signatures)

<table>
<thead>
<tr>
<th>(G) Reason</th>
<th>(H) Disp.</th>
<th>(J) Name</th>
<th>(K) Signature</th>
<th>(L) Date</th>
<th>(M) MSIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Design Authority D.E. Bowers</td>
<td>DE Bowers</td>
<td>9/1/99</td>
<td>89-13</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Design Agent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Cog. Eng. RR Bevins</td>
<td>RR Bevins</td>
<td>9/1/99</td>
<td>R3-25</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Cog. Mgr. KN Jordan</td>
<td>KN Jordan</td>
<td>9/1/99</td>
<td>R3-25</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>QA TL Bennington</td>
<td>TL Bennington</td>
<td>9/1/99</td>
<td>R3-25</td>
</tr>
</tbody>
</table>

18. Signature of EDT Originator  
   Date  
   Signature of EDT Originator: RR Bevins  
   Date: 9/1/99

19. Authorized Representative for Receiving Organization  
   Date

20. Design Authority/Co-ignant Manager  
   Date

21. DOE APPROVAL (if required)
   Ctrl No.
   ☐ Approved  
   ☐ Approved w/comments  
   ☐ Disapproved w/comments
Master Pump Shutdown MPS Software Quality Assurance Plan (SQAP)

Robert R. Bevins
CH2M Hill Hanford Group Inc., Richland, WA 99352
Richland, WA 99352
U.S. Department of Energy Contract DE-AC06-96RL18100

EDT/ECN: 630024  Org Code: 7C900  B&R Code: Total Pages: 37
UC: 2000  Charge Code: 109749

Keywords: Master Pump Shutdown System, Software Quality Assurance Plan (SQAP) MPSS, Tank Farm Restoration and Safe Operations

Abstract: The MPSS Software Quality Assurance (SQAF) describes the tools and strategy used in the development of the MPSS software. The document also describes the methodology for controlling and managing changes to the software.

*Windows NT is a registered trademark of Microsoft Corporation

TRADEMARK DISCLAIMER. Reference herein to any specific commercial product, process, or service by trade name, trademark, manufacturer, or otherwise, does not necessarily constitute or imply its endorsement, recommendation, or favoring by the United States Government or any agency thereof or its contractors or subcontractors.

Printed in the United States of America. To obtain copies of this document, contact: Document Control Services, P.O. Box 950, Mailstop HS-08, Richland WA 99352, Phone (509) 372-2420; Fax (509) 376-4889.
PROJECT W-314

SOFTWARE QUALITY ASSURANCE PLAN

FOR

MASTER PUMP SHUTDOWN SYSTEM

(MPSS)

Prepared for

CH2M HILL Hanford Group, Inc.

September 2000

Approval: J. L. Dowell, FFS/TFSRO, Control Systems Lead Engineer
Date: 9-13-00

Approval: P. J. Bedell, FFS/TFSRO, Principal Lead Engineer
Date: 9-13-00

Approval: R. M. Tanner, FFS/TFSRO, Project Manager
Date: 9-13-00

Approval: K. N. Jordan, CHG, Project Manager
Date: 9-18-00

Approval: D. E. Bowers, RPP, Design Authority
Date: 9-18-00

Approval: R. P. Raven, CHG, Retrieval Operations
Date: 9-13-00
<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date of Issue</th>
<th>Description</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>8/01/00</td>
<td>For CHG Review and Release into RPP documentation control system.</td>
<td>Comments Incorporated. Ready for Release.</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 INTRODUCTION</td>
<td>4</td>
</tr>
<tr>
<td>1.1 Quality Assurance Overview</td>
<td>4</td>
</tr>
<tr>
<td>1.2 Scope</td>
<td>5</td>
</tr>
<tr>
<td>1.3 Acronyms and Definitions</td>
<td>6</td>
</tr>
<tr>
<td>2.0 SQAP PROCESS</td>
<td>7</td>
</tr>
<tr>
<td>2.1 Precision Integration Products Checklist</td>
<td>7</td>
</tr>
<tr>
<td>2.2 MPSS Development Staff Personnel Requirements</td>
<td>8</td>
</tr>
<tr>
<td>2.3 Configuration Management</td>
<td>8</td>
</tr>
<tr>
<td>3.0 REFERENCES</td>
<td>8</td>
</tr>
<tr>
<td>APPENDIX A PRECISION INTEGRATION PRODUCTS CHECKLIST</td>
<td>9</td>
</tr>
<tr>
<td>APPENDIX B DEVELOPMENT PERSONNEL POSITION REQUIREMENTS</td>
<td>12</td>
</tr>
<tr>
<td>APPENDIX C MPSS DEVELOPMENT STAFF PERSONNEL PROFILE FORM</td>
<td>13</td>
</tr>
<tr>
<td>APPENDIX D CONFIGURATION MANAGEMENT PLAN INCLUDING SCR PROCESS</td>
<td>14</td>
</tr>
<tr>
<td>APPENDIX E CONFIGURATION CONTROL—SOFTWARE RELEASE PROCESS</td>
<td>29</td>
</tr>
</tbody>
</table>
1.0 INTRODUCTION

1.1 Quality Assurance Overview

This Software Quality Assurance Plan (SQAP) provides the basis for MPSS software quality assurance. The plan itself is based on activities within a Precision Integration life-cycle model (i.e., software development and maintenance model) developed by Fluor Federal Services (FFS). The basis for this plan is information contained within the FDH procedure, HNF-PRO-309, Revision 0, "Computer Software Quality Assurance Requirements".

Precision Integration (Figure 1) depends on several iterations (or cycles) of the following segments:

- Define (Requirements)
- Design
- Implement
- Test (Informal and Formal)

![Figure 1 Precision Integration Cycles](image-url)
The first cycle is referred to as the top cycle. The majority of development effort takes place in this iteration to avoid costly rework in future iterations. Each additional cycle refines the software system, but allows for changes to all aspects (e.g., a requirement change). As cycles are performed, the time duration of each cycle becomes increasingly shorter, as does the number of problems related to testing exceptions. This, in essence, meets an approved type of overall IEEE software lifecycle model, referred to as a "waterfall" type model.

The key to this SQAP is that it creates a balance between oversight and staff productivity. The W-314 project has many Phases. Phase I of MPSS is construction of an MPSS Operator Trainer, with migration of this MPSS system's Human Machine Interface (HMI) and logic to several other tank farms, and a full mock-up test of the migrated MPSS in FY01. Phase II sees continued expansion and equipment configuration updates to the system. Therefore, this plan shall deal with activities, through Phase II, which are entirely within the Precision Integration model shown in Figure 1, and that allows for maintenance in future phases.

The process shall include products for Define, Design/Implement, and Test segments. In addition, where ever informal maintenance is no longer adequate, a formal configuration management plan shall be instituted for all changes to the system software.

The configuration management shall include a method for releasing baseline versions of the MPSS, and reporting, fixing, and closing issues, enhancements and/or problems. Note that the MPSS Operator Trainer Modicon logic diagrams are currently configuration controlled within AutoCAD. A conversion to the RTP product line will occur to address safety class and general service designations through the MPSS. At that point, the converted drawings shall be controlled within RTP Net Arrays software, with version control provided by this plan.

1.2 Scope

This Software Quality Assurance Plan (SQAP) provides the plan strategy and description of the tools used in performance of the Master Pump Shutdown System (MPSS) software development and maintenance.

This document does not provide a description of the MPSS requirements. For more information related to the MPSS requirements refer to HNF-SD-W314-PDS-004.
1.3 Acronyms and Definitions

CATS: Computer Automated Testing System. A database application, or test engine, that takes specific test data tables and converts them into automatic and human interaction-based tests. The CATS gathers all test responses, comments, and compares results to generate sets of passing and exception reports.

ECN: Engineering Change Notice

EDT: Engineering Data Transmittal

FDH: Fluor Daniel Hanford

FFS: Fluor Federal Services

HMI Software: A Human-Machine Interface software package developed by Ci Technologies, Citect, is used to create the human-machine interface portion of the DAS. The PC-based package works within the Microsoft Windows NT environment to provide graphic displays with user-friendly controls.

IP: In Progress

MPSS: Master Pump Shutdown System. Operator HMI for setting up and verifying waste transfer routes from tank to tank (up to six simultaneous). Also has interlocks connected to leak detection devices to ensure orderly shutdown of affected transfer lines.

PC: Personal computer used with HMI software to provide the human-machine interface.

PDS: Project Development Specification

PE: Professional Engineer certification from the State of Washington.

PLC: The Programmable Logic Controller is the microprocessor-based industrial controller capable of real-time control. It provides all of the discrete and process control logic required for controlling and/or monitoring the process. Once the program has been loaded into the controller module, it will execute all control/monitoring functions even if connection to the HMI computer is severed or interrupted.

PM: Project Manager

QTP: Qualification Test Procedure

RCR: Review Comment Record
Real-time: Indicates that monitoring and control signals are being processed and implemented in an acceptable time frame which is usually after an imperceptible time delay after the actual process events.

RPP: River Protection Project

SIMCart: Simulator Cart. When used with CATS, SIMCart provides a method for emulating all applicable field I/O virtually so as to fully test a finished system’s HMI and PLC.


V&V: Verification and validation. Process of ensuring that software products and/or systems are reviewed and checked/tested thoroughly at the different stages of implementation in the lifecycle model.

2.0 SQAP PROCESS

This section describes the tools available, and how and when to apply these tools. The process is primarily document and form based. The following are the tools that shall be described.

- Appendix A Precision Integration Products Checklist
- Appendix B Development Personnel Requirements
- Appendix C MPSS Development Staff Personnel Profile Form
- Appendix D Configuration Management Plan Including SCR & Testing Evaluation Process
- Appendix E Configuration Control—Software Release Process

2.1 Precision Integration Products Checklist

In Appendix A is the primary tool—a checklist that shows the different Precision Integration Iteration Segment products generated for the MPSS. The Appendix A checklist is used to assure that when an iteration segment (i.e., define, design, implement, test) is entered, the effect of the system change or implementation is fully evaluated, and the products are generated or modified with appropriate V&V. This will ensure that 1) the effect of a change to the system is evaluated before the change is made, and 2) the system documentation reflects the current state of the system after a change is implemented. This checklist is to be reviewed 1) during implementation of the initial system and 2) for SCR/PR(s) implementation during system upgrades and maintenance.
2.2 MPSS Development Staff Personnel Requirements

This list in Appendix B provides staffing requirements for the MPSS Software Development Personnel. The form is Appendix C shall be filled out for each person and kept in a desk reference by the MPSS PM.

2.3 Configuration Management

There are two procedures, in Appendix D and E, that account for MPSS developed software configuration management and releases respectively.

3.0 REFERENCES

1) HNF INFORMATION RESOURCE MANAGEMENT PROCEDURES

HNF-PRO-309, Computer Software Quality Assurance Requirements, Revision 1
HNF-PRO-2778, IRM Application Software System Life Cycle Standards, Revision 0

2) HNF ENGINEERING PROGRAM

HNF-PRO-244, Engineering Data Transmittal Requirements
HNF-PRO-440, Engineering Document Change Control Requirements
## APPENDIX A PRECISION INTEGRATION PRODUCTS CHECKLIST

**Review Process Products**  (To be Updated by MPSS PM as Products are Released—Check when Done and Fill in Tracking ID)

<table>
<thead>
<tr>
<th>Project Iteration Segment</th>
<th>Review Product Identifier</th>
<th>Title</th>
<th>Expected Tool Used</th>
<th>Responsible</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DEFINE</strong></td>
<td>1) HNF-SD-W314-TI-004</td>
<td>PDS</td>
<td>EDT/ECN Process</td>
<td>Client</td>
<td>Describes specific requirements that may be utilized as acceptance criteria.</td>
</tr>
<tr>
<td></td>
<td>2) HNF-SD-W314-TI-008</td>
<td>PDC</td>
<td></td>
<td>Change Control Board (CCB)</td>
<td>Describes enhancements to the system authorized outside of and complementary to the PDC/PDS.</td>
</tr>
<tr>
<td></td>
<td>3) Enhancements per modifications to 1) or 2) or per SCR/PR form.</td>
<td>SCR/PR(s)</td>
<td>SCMP Process</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DESIGN</strong></td>
<td>1) Validation Report (V&amp;V) of design per PDC/PDS</td>
<td>RVR</td>
<td>EDT/ECN Process</td>
<td>MPSS PE</td>
<td>Describes how the implemented System design meets the PDS Requirements.</td>
</tr>
<tr>
<td></td>
<td>2) V&amp;V of SCR/PR(s) enhancements</td>
<td>SCR/PR(s)</td>
<td>SCMP Process</td>
<td>MPSS PE</td>
<td>Ensures that the SCR/PR(s) effects and enhancements are documented in Programmer’s/Design Document</td>
</tr>
<tr>
<td></td>
<td>3) Programmer’s/Design Document</td>
<td>PROG/DES</td>
<td>EDT/ECN</td>
<td>MPSS PE</td>
<td>Describes the system design for HMI screens, taglists, functions, buttons, general operations, and generic functional logic of the PLC.</td>
</tr>
<tr>
<td>Project Iteration Segment</td>
<td>Product Identifier</td>
<td>Title</td>
<td>Expected Tool Used</td>
<td>Responsible</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------</td>
<td>-------</td>
<td>--------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>IMPLEMENT</td>
<td>1) V&amp;V design implementation</td>
<td>PDC, PDS Check, SCR/PR(s) Check</td>
<td>Yellow-Line Check Process, SCMP Process</td>
<td>HMI and PLC Engineers /MPSS PE, HMI and PLC Engineers /MPSS PE</td>
<td>Check of HMI, PLC and database implementation per design document. Check of HMI, PLC and database implementation per design document.</td>
</tr>
<tr>
<td>TEST</td>
<td>1) All releases of software code for test to a physically separate storage device per SCMP Appendix D numbering Scheme. 2) V&amp;V system implementation per test cases</td>
<td>TEST REL, QTP and/or ATP and/or OTP and/or SCR/PR(s) test(s)</td>
<td>O/S Network Drive AP012/FTN/WPROJ/PROJECT/SW-314/RELEASE0.X&lt;release date&gt;, Test Cases (e.g., CATS and/or paper-based). Test Evaluation Forms, SCMP</td>
<td>HMI and PLC Engineers /MPSS PE, HMI and PLC Engineers /MPSS PE</td>
<td>All MPSS Project configured electronic files, libraries, etc. including compiled code, source code, etc., for test. Check of HMI, PLC and database implementation per PDC, and/or, PDS, and/or SCR/PR(s) enhancements.</td>
</tr>
<tr>
<td>SYSTEM RELEASE</td>
<td>1) Releases of V&amp;V'd code to a physically separate storage device per SCMP Appendix D numbering scheme.</td>
<td>SYSTEM REL</td>
<td>O/S Network Drive AP012/FTN/WPROJ/PROJECT/SW-314/RELEASE0.X&lt;release date&gt;</td>
<td>HMI and PLC Engineers /MPSS PE</td>
<td>All MPSS Project configured electronic files, libraries, etc. including compiled code, source code, etc.</td>
</tr>
<tr>
<td>Concurrent Activities</td>
<td>Description</td>
<td>Title</td>
<td>Tool Used</td>
<td>Responsible</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>---------</td>
<td>----------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>CONFIGURATION MANAGEMENT</strong></td>
<td>Internal Work Control 1) SCR Logbook</td>
<td>CFMG/SCR</td>
<td>SCR/PR (Appendix D)</td>
<td>MPSS PE</td>
<td>Tracks all system problem reports or change requests (e.g., enhancement).</td>
</tr>
<tr>
<td></td>
<td>2) Test Evaluation Form Logbook</td>
<td>CFMG/TEF</td>
<td>Test Evaluation Form (TEF) (Appendix D)</td>
<td>MPSS PE</td>
<td>Tracks all SCR/PR testing Evaluations and Results.</td>
</tr>
<tr>
<td></td>
<td>3) Release Log and Logbook</td>
<td>CFMG/REL</td>
<td>Network Drive AP012/EDN/PROJ/PROJ/ECTS/W-314/RELEASED.X&lt;release date&gt; (Appendix E)</td>
<td>Lead HMI/MPSS PE</td>
<td>Tracks releases of MPSS baselines</td>
</tr>
<tr>
<td><strong>TRAINING RECORDS</strong></td>
<td>Internal Work Control</td>
<td>TR</td>
<td>Form (Appendix B)</td>
<td>MPSS PM</td>
<td>Position certification and training requirements</td>
</tr>
<tr>
<td></td>
<td>1) Development Personnel Position Requirements</td>
<td>PROF</td>
<td>Form (Appendix C)</td>
<td>MPSS PM</td>
<td>Personal profiles to document meeting MPSS Development Personnel Requirements.</td>
</tr>
</tbody>
</table>
APPENDIX B DEVELOPMENT PERSONNEL POSITION REQUIREMENTS

All persons filling the below positions on the Project W-314 MPSS development must be certified by the MPSS Project Engineer or Manager to meet the listed qualifications for the position. The certification is to be documented on the form in Appendix C. If the position required is not listed below, please contact the MPSS PM.

PROJECT MANAGER/ENGINEER/LEADS:

1) A degree in engineering or a Washington State Professional Engineering License.
2) 2 years project management experience.
3) Current with FFS procedure training per the EMPORTS reading list.

PLC PROGRAMMERS:

1) 2 years of engineering training/experience related to control systems.
2) Knowledge of ladder and function block logic (Note: a junior programmer with less than two years experience can work under the guidance of a qualified programmer).
3) Current with FFS procedure training per the EMPORTS reading list.

HMI PROGRAMMERS:

1) 2 years experience developing human machine interface screens with Citect or equivalent HMI development tool (Note: a junior programmer with less than two years experience can work under the guidance of a qualified programmer).
2) Current with FFS procedure training per the EMPORTS reading list.

DATABASE PROGRAMMERS:

1) 2 years experience developing relational databases using Microsoft Access or equivalent database software (Note: a junior programmer with less than two years experience can work under the guidance of a qualified programmer).
2) Current with FFS procedure training per the EMPORTS reading list.

LOGIC REVIEWERS:

1) Washington State Professional Engineering License in either Control Systems or Electrical engineering.
2) Current with FFS procedure training per the EMPORTS reading list.

INTEGRATION TESTERS:

1) A degree in engineering or background in a technical field.
2) Current with FFS procedure training per the EMPORTS reading list.

HMI TESTERS:

1) A degree in engineering or background in a technical field.
2) The ability to effectively operate a PC using Microsoft Windows and Office Programs.
## APPENDIX C  MPSS DEVELOPMENT STAFF PERSONNEL PROFILE FORM

### Project W-314 MPSS
**Personnel Profile Form**

<table>
<thead>
<tr>
<th>Name (First MI Last):</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Position Title (See Appendix B of MPSS SQAP—more than one title may be submitted for multi-tasking personnel):</th>
</tr>
</thead>
</table>

**Note:** If a reviewer, ensure that the person is independent of the work being inspected, unless informal.

<table>
<thead>
<tr>
<th>Position-Related Qualifying Education, Certification, and Experience:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>If deficient for position requirements, mark here:</th>
</tr>
</thead>
</table>

If marked, but personnel is to be used on a task—state action plan, completion date, and mentoring position engineer below:

<table>
<thead>
<tr>
<th>Reviewed by: (Print and Sign Name and Date)</th>
</tr>
</thead>
</table>
APPENDIX D CONFIGURATION MANAGEMENT PLAN INCLUDING SCR PROCESS

Configuration Management Plan For Master Pump Shutdown System (MPSS)

CONTENTS

1.0 INTRODUCTION

2.0 MANAGEMENT

3.0 SOFTWARE CONFIGURATION MANAGEMENT ACTIVITIES
   3.1 CONFIGURATION IDENTIFICATION
   3.2 CONFIGURATION CONTROL
   3.3 CONFIGURATION STATUS ACCOUNTING
   3.4 AUDITS AND REVIEWS
   3.5 ACCESS CONTROL
   3.6 BACKUP AND RECOVERY

4.0 TOOLS, TECHNIQUES AND METHODOLOGIES

5.0 SUPPLIER CONTROL

6.0 RECORDS COLLECTION AND RETENTION

7.0 REFERENCES

8.0 SOFTWARE CHANGE REQUEST AND PROBLEM REPORT FORM

9.0 MPSS SCR/PR TESTING EVALUATION FORM
1.0 INTRODUCTION

1.1 PURPOSE

This Configuration Management Plan (CMP) provides the instructions for change & version control of the Master Pump Shutdown System (MPSS) software.

1.2 SCOPE

This plan applies to the MPS system software to be used by CH2MILL (CHG) and includes the computer software source and executable code. This also applies to special configurations of vendor software (e.g., Windows NT 4.0, etc.). Control of information produced by the software once it has been exported is the responsibility of the receiving organization. This plan is required for formal 1) development and 2) production release and system maintenance. Changes to design basis documentation, via ECN, will require following this CMP to evaluate MPSS impacts.

1.3 OVERVIEW

The primary purpose of the MPSS is to provide an automated approach (via PLC & an HMI) to the safe and orderly shutdown of waste transfers in case of leak detection.

1.4 DEFINITIONS

Production: Pertaining to the status of a given system following acceptance by the customer.

Software Change Request and Problem Report (SCR/PR): A document that identifies a proposed change to or suspected problem with the WCS hardware and/or software. An SCR/PR may identify a new function, modify an existing function or report suspected problems of the software.

System and Software Configuration Management (SCM): A set of management disciplines within the context of the software engineering process that applies technical and administrative direction and surveillance. It identifies and documents the functional and physical characteristics of a product, controls changes to those characteristics, and it records and reports the change processing and implementation.

SCR/PR Testing Evaluation Form: A document that allows an SCR/PR(s) to have testing analysis performed to identify appropriate test cases to be planned. The test cases are then attached to this form, approved by the change control board, and the tests performed to close out the SCR/PR process.
2.0 MANAGEMENT

2.1 ORGANIZATION

CH2MILL Hanford (CHG)--shall be designated as MPSS system owner, operator and maintenance authority.

Fluor Federal Services (FFS)--shall be designated MPSS developer, maintainer and custodian in conjunction with CH2MILL Hanford.
### 2.2 RESPONSIBILITIES

<table>
<thead>
<tr>
<th>Function</th>
<th>Organization</th>
<th>Individual</th>
<th>Responsibilities relative to this plan.</th>
</tr>
</thead>
</table>
| Design Authority             | CHG          | Dave Bowers      | o Design Authority (Cognizant Engineer)  
o Approves SQAP  
O Approves OT (Operator Trainer)  
O Communicates Impacts (due to PDS, equipment, etc.) via SCR/PR  
O Approves SCR/PR that differ from PDS-based OT  
O Approves QTP and Oversees QTP, and Reviews QTR  
O Reviews All SQAP Products Generated  
O Reviews and Approves All SCR/PR Testing Evaluation Forms Generated, and Approves Test Results |
| Lead Engineer (LE)           | FFS          | Dwight Brayton   | o Overall Responsibility For SCM and Design Agent of record.  
o Evaluate and implement changes resulting from SCR/PR.  
O Evaluate SCR/PR for impact on cost, schedule, & deliverables.  
O Maintain SCR/PR and SCR/PR log (log is paper-based and contained in a binder) at 1200 Jadwin, floor 3/cubicle 3.  
O Maintain a library of all associated correspondence, personnel assignments, documentation, deliverables, reports, logs, software, etc., in their most up-to-date version. Location is at 1200 Jadwin, floor 3.  
O Provide CCB liaison for testing evaluation forms. |
| Change Control Board (CCB) Chair | CHG          | Bob Bevins      | o Accept/prioritize work proposed by SCR/PR.  
O Approve or disapprove test plan/completed testing results from SCR/PR implementation  
O CCB members include CCB Chair, Design Authority, and others as appointed by the CCB Chair on a permanent or case by case basis, with assistance and input from the Lead Engineer. |
| System and Software Developer & Maintainer | FFS          | Dwight Brayton   | o Provides development and maintenance |
| System and Software Custodian | FFS          | Dennis Lauhala   | o Ensure backup and recovery of application and software.  
O Ensure proper labeling and storage of backup media, as applicable.  
O Ensure correct software is installed for production use.  
O Ensures problem reports are distributed to development team/users. |
| Software Engineer(s)         | FFS          | Various          | o Do the work identified in SCR/PR and conduct tests.  
O Ensure adequate tests are performed—fill out test evaluation form.  
O Document test results and include with change request, or indicate supporting document number if applicable.  
O Obtain independent review of SCR/PR, as required. |
| Report problems and submit change requests | Any Org. Involved w/ MPSS | Anyone In MPSS Organization | o Identify and report problems on a SCR/PR form.  
O Submit changes on a SCR/PR form. |

(1) The appointed individual may be changed via internal memorandum or e-mail, signed by the organizational manager. Memorandum to be maintained in the MPSS PM desk files. Modification to this SCMP not required.
2.3 IMPLEMENTATION

This CMP becomes effective whenever a problem or change request is identified, either internally (prior to release to CH2MHILL Hanford for Production) or externally. Overall responsibility for the SCM activity rests with the Lead Engineer described in Section 2.2. Version change control of source code and executables becomes effective when released for correction of SCR groups, testing for major revisions, and/or released for production on minor revisions.

2.4 POLICIES AND PROCEDURES

Configuration management of the MPSS software items will be in guidance from HNF-PRO-309, particularly with regards to Software Control, Change Request & Problem Reports, and Document Approvals.

3.0 SOFTWARE CONFIGURATION MANAGEMENT ACTIVITIES

Configuration Management will be applied to the MPSS software items per the requirements established and steps provided herein.

3.1 CONFIGURATION IDENTIFICATION

3.1.1 Application Software

Design basis documentation which sets the foundation for the configuration of the MPSS software is found in the PDS associated references.

The local HMI which displays messages, alarms, and information to the operator are via Personal Computers with Windows NT O/S and using Citect as the Human Machine Interface (HMI). The HMI is used for all monitoring and initiation of control.

Each production for HMI software releases shall be a grouping of the code and executable software products, and any modifications to vendor software (e.g., configurations, etc.). The release is assigned a unique release number by the MPSS System and Software Custodian.

The software release number is of the form R.r as described in HNF-PRO-464, Software Control. Please refer to the sample form in the “Release Cover Sheet and Revision Record”, Appendix E.

If the R is absent, the MPSS software is still in the Development phase.

3.1.2 Software Products

Each software product (e.g., the application software development packages, the operating system software, the network communications software, etc.) is assigned a unique product name.
and release version number by the appropriate vendor and will be used as identification as much as practical on the software release documentation.

3.1.3 Computer Hardware

Computer hardware, such as installed field PLCs is controlled by normal Hanford administrative procedures (e.g., H-2 drawing system via Engineering Data Transmittals (EDT) and Engineering Change Notices (ECN)), Ref. 2. Configuration control is required by the MPSS, only for the cases of 1) identification of the minimum equipment necessary for operation and 2) evaluation of MPSS local and remote HMI and/or PLC impact, caused by field hardware changes that are part of the design basis documentation set--via an SCR/PR.

3.1.4 Documentation

Each MPSS document is assigned a unique name, number, and revision in accordance with the HNF/RPP documentation procedures and is documented.

MPSS SCR/PR forms shall be kept in local project files in log form by the Lead Engineer. When a Release of the MPSS system occurs, the Lead Engineer will ensure that the Release information is completed and associated SCR/PRs are updated.

MPSS SCR/PR testing evaluation forms shall be kept in local project files in log form by the Lead Engineer. When a Release of the MPSS system occurs, the Lead Engineer will ensure that the Release information is completed and associated testing evaluation forms are updated.

3.1.5 Application Reports

Control of application reports generated by the MPSS is not provided under this CMP, and is the responsibility of the software user organizations.

3.1.6 Removable Media Labels

Removable media shall be labeled consistent with the following information on the label:

- Media identifier (i.e., disc number)
- Software identification
- Software revision identification ("R.r", "R" = major and "r" = minor software changes, e.g. 1.0)
- Software or data name or description
- Responsible organization and software custodian’s name
- Recording date and time.
3.1.7 Directory Nomenclature

Original or backup source and executable software placed on media containing multiple versions/revisions shall be segregated using the available directory/subdirectory structure.

A major directory shall be provided for the software product, labeled with the product mnemonic. Subdirectories shall be provided for each major revision. Each minor revision shall be contained in a separate sub-subdirectory, uniquely identified with the appropriate revision number. The subdirectory name shall contain the major and minor revision number, separated by a period. For example:

AP012/FDNWPROJ/PROJECTS/W-314/RELEASE0.X<release date>

A sample directory listing is shown:
3.2 CONFIGURATION CONTROL

SCR/PR approvals are recorded and submitted using the SCR/PR form.

E-mail approvals for processing SCR/PRs may be substituted for handwritten approvals. When e-mail approvals are used a copy of the e-mail approval must be attached to the SCR/PR.

Telephone approvals for processing SCR/PRs may be used, but subsequently, must be documented on the SCR/PR form or with an e-mail approval.

SCR/PR testing evaluation form approvals are recorded and submitted using the testing evaluation form, or electronic equivalent (e-mail approval okay).

3.3 CONFIGURATION STATUS ACCOUNTING

The configuration status of all controlled items is documented in Release information per Appendix E of the MPSS SQAP. In addition, the status of all SCR/PRs, testing evaluation forms, and associated releases will be maintained and is available from the Lead Engineer.

3.4 AUDITS AND REVIEWS

The MPSS and associated documentation, including software change control, will be available for audit during normal working hours. The MPSS System and Software Administrator should periodically audit the project file and change control documentation to ensure compliance. Other surveillance and audits are the responsibility of other outside organizations and are outside the scope of this plan.

All changes and tests shall be reviewed (verified) by an independent technical person. For minor changes and releases, test results may be attached to the SCR/PR. For major changes and releases, refer to Testing Evaluation Form log.

Should changes require major modifications or enhancements, the Lead Engineer, Software Engineer, and Design Authority will determine if a formal plan will be prepared. The formal plan will identify appropriate technical, V&V and QA reviews consistent with HNF procedures and commensurate with the complexity of the change.

3.5 ACCESS CONTROL

Access control for operation of the MPSS software is administrative. However, to make changes to the MPSS code requires software other than what is available to the user through the local or remote HMI.
3.6 BACKUP AND RECOVERY

Backup shall be from the most recent set of release files per Section 3.1.7.

Backup of the source code and executable files that constitute each product release is done by the software custodian onto the fileserver backup partition selected and documented by the Software Custodian—for example “\DCH\PROJECTS\WCS\SCMP” (see section 3.2.1) at the time of release. The Software Custodian is responsible for verifying that the backup is in place and the appropriate files exist.

Recovery shall be accomplished by rewriting the appropriate files from the master media onto the production fileserver or its replacement. This shall be accomplished by the System and Software Custodian or Lead Engineer/Software Engineer as needed. Should the master media be simultaneously corrupt, recovery shall be from the backup fileserver partition.

4.0 TOOLS, TECHNIQUES AND METHODOLOGIES

Tools and instructions for software administration and usage are contained in Ref. 1.

All MPSS software release modifications will be completed and certified in a test environment where possible. Tests are informal up to the point of the QTP. At this point, rigorous testing methods shall be utilized to test the MPSS. This includes a testing evaluation for each SCR/PR

All MPSS software modifications/enhancements will be completed and certified in a test environment where possible. These changes will be implemented into the production environment only after the Design Authority has reviewed and approved the test results and the Change Control Board has approved the implementation. Modifications and enhancements will be grouped logically into production releases.

5.0 SUPPLIER CONTROL

The System and Software Developer & Maintainer will ensure that new releases and installation of the vendor application and software product are tested prior to its being placed in production. Changes in vendor application and/or software product will be processed as a change request or problem report with the same approval requirements as a locally generated change.

The System and Software Developer & Maintainer will maintain a software project file or binder of all system and software-related project documentation, correspondence, and project produced documents. This may be in the form of reference to released (e.g., HNF) documentation. Vendor provided materials and manuals will be maintained by the System and Software Custodian. This software project file or binder will maintain the most current version of all documents for the life
6.0 RECORDS COLLECTION AND RETENTION

The MPSS System and Software Developer and Maintainer will process software development and maintenance records in accordance with HNF-PRO-309. These records, include at a minimum the SCR/PR log book and SCR/PR form entries, the Testing Evaluation log book and Testing Evaluation form entries, and will be kept by the Lead Engineer in local project files and/or logbooks.
7.0 REFERENCES

1) HNF INFORMATION RESOURCE MANAGEMENT PROCEDURES

HNF-PRO-433, Small Job Development,
HNF-PRO-555, System Configuration Management Plan,
HNF-PRO-464, Software Control
HNF-PRO-564, Records Retention and Disposal.

2) HNF ENGINEERING PROGRAM

HNF-PRO-244, Engineering Data Transmittal Requirements
HNF-PRO-440, Engineering Document Change Control Requirements
### MPSS SYSTEM AND SOFTWARE CHANGE REQUEST AND PROBLEM REPORT FORM

#### NOTE: Submitter Fills In Parts 1-8 (NON-GRAY)

1. **SCR/PR Type:** [ ] Problem [ ] Enhancement

2. **Submitted By:**

3. **Project Name:**

4. **Areas Affected (check):**
   - [ ] PLC
   - [ ] HMI
   - [ ] Database
   - [ ] Operating System

5. **Submitter's Priority [ ]**
   - (1 = Critical 2 = Very Important 3 = Important 4 = Inconvenient 5 = Interesting)

6. **Requested Completion Date:**

7. **Task/Change/Problem Title (One Sentence Description):**

8. **Detailed Description/Justification (Attach Additional Sheet If Necessary):**

<table>
<thead>
<tr>
<th>Decision By:</th>
<th>[ ] Accept [ ] Modify [ ] Reject [ ] Defer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To:</td>
<td>Target Release Date:</td>
</tr>
<tr>
<td>Resolution:</td>
<td></td>
</tr>
</tbody>
</table>

**System and Software Programs, Modules or Files Affected:**

<table>
<thead>
<tr>
<th>Task Completed By:</th>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verified By:</td>
<td>Date:</td>
</tr>
<tr>
<td>Actual Release Version:</td>
<td>Date:</td>
</tr>
<tr>
<td>Closed By:</td>
<td>Date:</td>
</tr>
</tbody>
</table>
These instructions are for preparing the Change Request or Problem Report. If more space is needed, use blank pages and attach to the SCR/PR form. This will be the record of the change request or problem report.

Submitter (Anyone In MPSS Organization may submit):

1. Fill out Sections 1-8 of the form—DO NOT fill in gray areas.
2. Suggestions for SCR resolution may be put into the Detailed Description section.
3. Provide a description of the changes requested or the problems being reported.
4. Attach additional sheets if necessary.
5. An E-mail to start the process is acceptable as long as an SCR form is filled out and logged.

Lead Engineer:

1. On receipt, enter into the MPSS SCR/PR Log. Enter the next SCR number on the form.
2. Track information by entering into the SCR database.
3. Enter the date received.
4. Enter current Version/Revision of the product.
5. Evaluate SCR/PR or group of SCR/PRs against Appendix A of this SQAP. Check when complete, and ensure activities are completed.
6. Review change request or problem with development personnel.
7. Note that SCR/PR may require attached cost estimate and planning by the Lead Engineer if extensive change or testing are anticipated.
9.0 MPSS SCR/PR TESTING EVALUATION FORM

<table>
<thead>
<tr>
<th>Log ID #</th>
<th>Summary Information Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCR/PR Number(s) to be tested:</td>
<td></td>
</tr>
<tr>
<td>1. Submitted By:</td>
<td></td>
</tr>
<tr>
<td>2. Date:</td>
<td></td>
</tr>
<tr>
<td>3. Current Release:</td>
<td></td>
</tr>
<tr>
<td>4. Describe Overall Impact to MPSS System from SCR Changes (document for each SCR):</td>
<td></td>
</tr>
<tr>
<td>5. Check the Box Indicating Analysis to be performed for each SCR(s)—List SCR(s)/or ALL:</td>
<td>6. Testing</td>
</tr>
<tr>
<td>[ ] Perform Design Analysis and Impacts Review (attach review) SCR/PR(s):</td>
<td>[ ] SCR/PR(s) test cases (attach w/ results)</td>
</tr>
<tr>
<td>[ ] Perform Automated Cicode and/or Object Cross-Reference (attach results) SCR/PR(s):</td>
<td>[ ] QTP test</td>
</tr>
<tr>
<td>[ ] Perform Automated Syntax/Spelling Check (attach results) SCR/PR(s):</td>
<td>[ ] ATP test</td>
</tr>
<tr>
<td>[ ] Perform Other (specify and attach results) SCR/PR(s):</td>
<td>[ ] OTP test</td>
</tr>
<tr>
<td>Areas Affected (check):</td>
<td>Reference Number:</td>
</tr>
<tr>
<td>[ ] PLC [ ] HMI [ ] Database [ ] Operating System</td>
<td>(Provide Review Copy)</td>
</tr>
<tr>
<td>7. Overall Test Approach Justification Summary for items in 6:</td>
<td></td>
</tr>
</tbody>
</table>

FOR MPSS CCB USE ONLY: SCR Resolution Information

| Decision By Change Control Board Chair/Desigee: | [ ] Accept [ ] Modify [ ] Reject [ ] Defer |
| Assigned To: FFS | Target Release Date: |
| Reasons (If Modify, Reject or Defer—attach additional sheets as required): |
| Task Completed By: FFS | Date: |
| Verified By Chair/Desigee: | Date: |
| Actual Release Version: | Date: |
| Closed By Chair/Desigee: | Date: |

These instructions are for preparing the SCR/PR Testing Evaluation Form. If more space is needed, use blank
pages. This will be the record of the testing evaluation for the SCR/PR.

Submitter (Software Engineer):

1. Fill out Sections 1-7 of the form—DO NOT fill in gray areas.
2. Suggestions for SCR resolution may be put into the Detailed Description section.
3. Provide a description of the testing, including analysis and SCR/PRs affected.
4. Attach additional sheets if necessary.

Lead Engineer:

1. On receipt, enter into the MPSS SCR/PR Testing Evaluation Form Log. Enter the next SCR/PR Testing Evaluation Log ID # onto the form.
2. Forward, when appropriate, for review by the Change Control Board (CCB) Chair for action.
3. Receive, when completed by CCB, and assign for testing per form.
4. Forward, when testing is complete, to CCB for verification and closure.

Change Control Board Chairman:

1. Receive form for review and accept, modify, reject or defer on form. Give reason. Return to Lead Engineer for action.
2. Receive, when completed by Lead Engineer, test results for accepted forms.
3. Verify and take actions to close Testing Evaluation Form and send to Lead Engineer.
APPENDIX E CONFIGURATION CONTROL—SOFTWARE RELEASE PROCESS

Process for Internal Software Release(s)

For an Internal release of Software within a FFS Project, Teams should follow the described process where applicable. This process needs to be an iterative function, as an example - leaving testing (other than the standard review of one's own work) to the end invites unnecessary risk and delays to timetables.

The Project Team shall maintain two versions of the current release. One version will be a developmental version that will be in a continued state of flux as developers add enhancements and correct defects to the application, the other will be a testing platform that will remain stable allowing testers a static plane from which to work.

![Iteration Process Diagram]

**ORIGINATE**

Generate Software Change Request (SCR/PR) per SCMP (e-mail as temporary SCR okay).

**REVIEW/ASSIGN**

LE Determine(s) whether SCR/PR is a defect or an enhancement

A. Prioritize accordingly (typically a bug fix will have a higher priority & an enhancement will be accompanied with a charge code)

B. SCR/PR meetings shall be held as required to document priority of SCR/PR open list.

**TEST**

Focus on achieving the following before closing an SCR/PR.

Reliability: fix operates without crashing, hanging, causing exceptions, or
leaking resources

**Functionality:** fix addresses the problem & meets established PDS requirements

**Application Performance:** The application responds in a timely manner

**System Performance:** The application continues to perform as designed when it is subjected to production load. For every instance where the application does not meet expectations an SCR/PR is generated or the current SCR/PR is updated.

**RELEASE**

The Project Team will maintain two versions of the current release

- Development Version (dynamic)
- Testing Version (static)

**Approval**

Based on SCR/PR(s) successful testing completion. The development team issues a new release. This release, once reviewed by Project Management, will replace the existing release.

Use the Release form to document the release.

**New Release**

Replaces current Development/Testing versions of existing release

**Old Release**

Saved within the project directory

**Current MPSS Release Procedure (Development—FY00 and FY01)**

**Purpose:** Describe the Release Process used to release a version from MICRON2 (Devel Server) to MICRON3 as a test server and MICRON4 as a test client.

**Note:**

The structure of the project is:

- Main Project = MPSS
- Sub Projects = CBS, TR, WTA

The version number x will be used for all projects.

Right now, the "designated backup media" is an empty Jaz disk - all W314 workstations have a Jaz drive.

**Applications used for Release:**

- Windows NT Explorer
- Citect Explorer
- Citect Project Editor

1. **Devel Server (MICRON2):** Backup the development version and move to the designated backup media, using the next release number in the filename (<project name>_r0x.CTZ).
Make sure to choose "compression" and "save subdirectories".

a. Citect Explorer -> Tools -> Backup

b. Backup each of the 4 projects: MPSS, CBS, TR, WTA

c. Backup Project MPSS
   check: Compression
   check: Save Subdirectories
   File name: MPSS_r0x.CTZ

d. Backup Project CBS
   check: Compression
   check: Save Subdirectories
   File name: CBS_r0x.CTZ

e. Backup Project TR
   check: Compression
   check: Save Subdirectories
   File name: TR_r0x.CTZ

e. Backup Project WTA
   check: Compression
   check: Save Subdirectories
   File name: WTA_r0x.CTZ

f. Move the backup files to Jaz drive.

2. Test Server(MICRON3): Restore the backups to a new project on the test server computer (MICRON3)

a. Citect Explorer -> Tools -> Restore

b. Restore the subprojects before restoring the main project.

c. Restore Project WTA
   Restore from: Jaz drive
   To: New Project
   Name: WTA_r0x.ctz
   Location: C:\citect\user

d. Restore Project Trainer
   Restore from: Jaz drive
   To: New Project
   Name: TR_r0x.ctz
   Location: C:\citect\user
Software Quality Assurance Plan for MPSS

- e. Restore Project CBS
  - Restore from: Jaz drive
  - To: New Project
  - Name: CBS_r0x.ctz
  - Location: C:\citect\user

- f. Restore Project MPSS
  - Restore from: Jaz drive
  - To: New Project
  - Name: mpss_r0x.ctz
  - Location: C:\citect\user

3. Server(MICRON3): Copy files from 'c:\citect\user\mpss_r0x\files\test comms' into 'c:\citect\user\mpss_r0x'. Replace all existing files.

4. Pack the files.
   a. Citect Project Editor -> File -> Pack

5. Server(MICRON3): Compile the project
   a. Citect Project Editor
   b. Select Project MPSS
   c. File -> Compile

   On the test server computer, go to the "Files" subdirectory of the project directory created in Step 2.
   Copy the file MPSS.MDB to C:\Citect\Data.

7. Server(MICRON3): On Test Server Computer, change the computer set up in Citect Explorer.
   a. Citect Explorer -> Tools -> Computer Setup
   b. Citect Computer Setup Wizard
      Express setup
   c. Computer Role Setup
      Server and Display Client
   d. Project Setup
      Project Name: mpss_r0x
   e. I/O Server Setup
      check: This computer is an I/O Server
      I/O Server Name: <default>
   f. Internet Server Setup
      uncheck: This computer is an Internet Server
   g. Alarms Setup
      check: This computer is an Alarm Server
      option: Primary Alarm Server
Software Quality Assurance Plan for MPSS

**h. Reports Setup**

- check: This computer is a Reports Server
- option: Primary Reports Server

**i. Trends Setup**

- check: This computer is a Trends Server
- uncheck: Trends Server supports redundancy

**j. Alarms, Reports and Trends Server Setup**

- This Server Name: MICRON3
- Other Server Name: (blank)

**k. Network Setup**

- Citect computer name: MICRON3

8. Server (MICRON3): Verify ODBC DSN.

   a. Control Panel -> ODBC DataSources -> User DSN tab
      
      Select w314
      
      Click Configure button

   b. ODBC Microsoft Access Setup
      
      - Data Source Name: w314
      - Database: C:\citect\data\mpss.mdb

      If not, then change using Select button.

9. Client (MICRON4):

   a. Citect Explorer -> File -> Add Project Link

      Add project links to the directory created in Step 2 for each project.
      
      - \micron3\croot\citect\user\mpss_r0x).
      
      - \micron3\croot\citect\user\CBS_r0x).
      
      - \micron3\croot\citect\user\TR_r0x).
      
      - \micron3\croot\citect\user\WTA_r0x).


    a. Citect Explorer -> Tools -> Computer Setup
    
    b. Citect Computer Setup Wizard
       
       - Express setup

    c. Computer Role Setup
       
       - Display Client

    d. Project Setup
       
       - Project Name: mpss_r0x

    e. Alarms, Reports and Trends Server Setup
       
       - Primary Server Name: MICRON3
       
       - Standby Server Name: (blank)

    f. Network Setup
       
       - Citect computer name: MICRON4
11. Client(MICRON4): Verify ODBC DSN.
   a. Control Panel -> ODBC DataSources -> User DSN tab
      Select w314
      Click Configure button
   b. Verify that
      Database: I:\citect\data\mpss.mdb
      If not, then change using Select button.

CURRENT RELEASE DOCUMENTATION

At a minimum, the release documentation shall include the release title, the release date, comments about the release including why the release is being made, and the files contained in the release directory. Refer to the form at the end of this Appendix (E) that shall be filled out for each release.

This documentation shall also be put electronically in the MPSS.CTZ file of the release directory. To retrieve the information, restore the project and access the file within “Citect\User\MPSS\[Release Number]\Files\Release Notes.txt. The following is an example shows typical release notes:

Project W-314, MPSS Release Notes:

--------------------------------------------------------

Release 0.7 - March 9, 2000

Added SFV Functionality, preliminary fix of communication losses to PLC, added association to CBS, cleared several SCRs since Rev 0.4 of MPSS. Revisions 0.5 and 0.6 fixed SCRs, though no real additions were part of each release.
All released subprojects as Rev 07.

Contained files:
    mpss_r07.ctz
    cbs_r07.ctz
    tr_r07.ctz
    wta_r07.ctz

--------------------------------------------------------

Release 0.4

SCRs still open: 101, 108, 114, & 115
Added floor drains, solid red on objects for acknowledged alarms, compressed libraries, began removing references to QueryArg table in mpss.mdb.
All released subprojects as Rev 04.
Contained files:
    mpss_r04.ctz
    cbs_r04.ctz
    tr_r04.ctz
    wta_r04.ctz

Release 0.3

Included project tree with Trainer, Create by Segment and Waste Transfer Annunciator subprojects.
All released subprojects as Rev 03.

Contained files:
    mpss_r03.ctz
    cbs_r03.ctz
    tr_r03.ctz
    wta_r03.ctz

Release 0.2

Included project tree with Trainer, Create by Segment and Waste Transfer Annunciator subprojects.
All released subprojects as Rev 01.

Contained files:
    mpss_r02.ctz
    cbs_r02.ctz
    tr_r02.ctz
    wta_r02.ctz

Release 0.1
Original release of project W-314, Master Pump Shutdown System
Contained files: mpss_r01.ctz
MPSS RELEASE FORM

At a minimum, the release documentation shall include the release title, the release date, comments about the release including why the release is being made, and the files contained in the release directory.

<table>
<thead>
<tr>
<th>Log ID # :</th>
<th>MPSS Release Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Testing Evaluation Form Log ID# (attach sheet):</td>
<td></td>
</tr>
</tbody>
</table>

1. Release Title:
2. Release Date:
4. Release Comments:

5. Check Categories Included and List Files Contained in Release:
   - [ ] PLC Logic:
   - [ ] HMI:
   - [ ] Database:
   - [ ] Operating System:

FOR MPSS CCB USE ONLY: | Release Information
----------------------|------------------
Closed By CHG CCB:    | Date:            
Closed By FFS:        | Date:            